
VIỆN KIỂM SÁT NHÂN DÂN 

TỐI CAO 

 

Số: 3659/VKSTC-C2 
V/v Hướng dẫn sơ đồ hóa nội dung 

vụ án hình sự 

CỘNG HOÀ XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự  do – Hạnh phúc        

  Hà Nội, ngày 30 tháng 9 năm 2022 

  
          Kính gửi:  

- Các đơn vị Vụ 1, Vụ 2, Vụ 3, Vụ 4, Vụ 5, Vụ 6, Vụ 7, 

  Văn phòng, Cục 1 Viện kiểm sát nhân dân tối cao; 

- Viện kiểm sát Quân sự TW; 

- Viện kiểm sát nhân dân cấp cao; 

- Viện kiểm sát nhân dân các tỉnh, thành phố trực thuộc TW.  

Thực hiện Chương trình, Kế hoạch công tác trọng tâm năm 2022, Cục 

Thống kê tội phạm và Công nghệ thông tin (Cục 2) đã biên soạn tài liệu Hướng 

dẫn sơ đồ hóa nội dung vụ án hình sự để triển khai thực hiện trong toàn Ngành. 

Tài liệu hướng dẫn được đăng tải trên Cổng thông tin điện tử của Viện kiểm sát 

nhân dân tối cao tại địa chỉ: http://vksndtc.gov.vn, chuyên mục “Thông báo” và 

chuyên mục “Công tác thống kê và Công nghệ thông tin”. 

Trong quá trình thực hiện nếu có vướng mắc, đề nghị các đơn vị liên hệ 

với Cục 2, Số điện thoại: 02438252558. 
 

Nơi nhận: 
- Như trên;  

- Đ/c Nguyễn Duy Giảng, PVT VKSNDTC 

    (để báo cáo); 

- Lưu: VT C2.                                                                                                                          
  

TL. VIỆN TRƯỞNG 

CỤC TRƯỞNG CỤC THỐNG KÊ TỘI PHẠM  

VÀ CÔNG NGHỆ THÔNG TIN 

 

 

(Đã ký) 

                               

       

 

Nguyễn Như Hùng 

 

http://vksndtc.gov.vn/


VIỆN KIỂM SÁT NHÂN DÂN TỐI CAO 

CỤC THỐNG KÊ TỘI PHẠM & CNTT 

====== 

 

 

 

 

 

 

 

 

 

 

HƯỚNG DẪN 

THỰC HIỆN SƠ ĐỒ HÓA NỘI DUNG VỤ ÁN 

 

 

 

 

 

 

 

 

 

 

 

 

Năm 2022   



  2  
 

MỤC LỤC 

 

 

I. MỤC ĐÍCH, YÊU CẦU ............................................................................ 4 

1. Mục đích ................................................................................................. 4 

2. Yêu cầu ................................................................................................... 4 

II. CÁC BƯỚC THỰC HIỆN ...................................................................... 4 

1. Chuẩn bị trang thiết bị và cài đặt các phần mềm .............................. 4 

2. Tóm tắt nội dung vụ án ......................................................................... 5 

3. Chuẩn bị hồ sơ, tài liệu để số hóa ........................................................ 5 

4. Số hóa, sắp xếp hồ sơ ............................................................................ 6 

5. Xây dựng báo cáo bằng phương pháp sơ đồ hóa ............................... 6 

III. GIỚI THIỆU MỘT SỐ PHẦN MỀM VÀ CÁC TÍNH NĂNG 

CHÍNH ............................................................................................................ 7 

3.1. Phần mềm ABBYY FineReader ....................................................... 7 

3.1.1. Các bước thực hiện chuyển đổi PDF sang Word ............................ 7 

3.1.2. Các bước thực hiện chuyển đổi Hình Ảnh sang Word ................... 9 

3.1.3. So sánh tài liệu .............................................................................. 10 

3.2. Phần mềm vẽ sơ đồ Draw-io............................................................ 13 

3.2.1.  Giao diện làm việc ....................................................................... 13 

3.2.2. Cách vẽ sơ đồ ................................................................................ 13 

3.2.3. Lưu sơ đồ và xuất file ................................................................... 15 

3.3. Phần mềm vẽ sơ đồ Microsoft Visio ............................................... 15 

3.3.1. Cách sử dụng ................................................................................. 15 

3.3.2. Thay đổi kiểu hình cho chủ đề ...................................................... 22 

3.3.3. Thay đổi theme, màu sắc, hiệu ứng cho sơ đồ tư duy .................. 24 

3.3.4. Thay đổi giao diện cho từng chủ đề .............................................. 26 

3.3.5. Thay đổi kiểu sơ đồ tư duy ........................................................... 26 

3.3.6. Thay đổi bố cục sắp xếp cho sơ đồ tư duy .................................... 27 

3.3.7. Sao chép sơ đồ (hình vẽ) sang Word ............................................ 28 

3.3.8. Xuất nội dung của sơ đồ sang Word ............................................. 30 

3.3.9. Xuất nội dung của sơ đồ sang Excel ............................................. 31 

3.4. Phần mềm vẽ sơ đồ Microsoft Word .............................................. 33 

3.4.1. Cách vẽ sơ đồ trong Word bằng Smart Art ................................... 33 



  3  
 

3.4.2. Cách vẽ sơ đồ trong Word bằng Shapes ....................................... 35 

3.4.3. Dùng Drawing Tools trong Word ................................................. 39 

3.4.4. Cách vẽ sơ đồ trong Word dạng biểu đồ ....................................... 43 

3.5. Vẽ sơ đồ tư duy bằng công cụ PowerPoint .................................... 45 

3.5.1. Cách vẽ sơ đồ tuy duy ................................................................... 45 

3.5.2. Cách liên kết trong PowerPoint .................................................... 47 

3.6. Phần mềm Iclone 7 ........................................................................... 52 

3.6.1. Chức năng chính ........................................................................... 52 

3.6.2. Cách sử dụng một số tính tăng của phần mềm ............................. 53 

3.7. Vẽ sơ đồ bằng phần mềm mã nguồn mở Xmind ........................... 61 

3.7.1 Chức năng chính ............................................................................ 61 

3.7.2. Cách sử dụng một số tính tăng của phần mềm ............................. 61 

3.8. Phần mềm dựng phim mã nguồn mở Blender .............................. 66 

3.8.1 Chức năng chính ............................................................................ 66 

3.8.2. Cách sử dụng một số tính tăng của phần mềm ............................. 66 

3.9. Phần mềm chỉnh sửa video và làm phim Corel Video Studio ..... 71 

3.10. Phần mềm thiết kế, mô phỏng Sweet home 3d ............................ 72 

3.11. Phần mềm Autodesk Maya ........................................................... 72 

  



  4  
 

HƯỚNG DẪN 

THỰC HIỆN SƠ ĐỒ HÓA NỘI DUNG VỤ ÁN 

 

I. MỤC ĐÍCH, YÊU CẦU 

1. Mục đích 

- Tăng cường ứng dụng công nghệ thông tin hỗ trợ, phục vụ cho các hoạt 

động nghiệp vụ của Kiểm sát viên trong công tác kiểm sát điều tra và báo cáo án.  

- Là cơ sở tiến tới xây dựng hồ sơ điện tử, thuận tiện trong việc lưu trữ, 

tra cứu hồ sơ. Giúp cho Kiểm sát viên thuận lợi trong việc trích dẫn, sử dụng các 

chứng cứ, tài liệu để tranh tụng tại phiên tòa. 

2. Yêu cầu 

- Phải nắm rõ nội dung vụ án, tóm tắt được nội dung để xây dựng kịch 

bản để thực hiện sơ đồ hóa. 

- Sử dụng thành thạo các phần mềm để có thể tái hiện bằng hình ảnh, sơ 

đồ nội dung, diễn biến hồ sơ vụ án hình sự. 

- Kết hợp những tài liệu, chứng cứ (chữ viết, âm thanh, hình ảnh, vật 

chứng,...) để phản ánh được một cách sinh động, trực quan diễn biến nội dung của 

vụ án. 

- Báo cáo bằng hình ảnh, video về vụ án phải ngắn gọn, dễ hiểu nhưng 

vẫn đảm bảo phản ánh đúng, khách quan, toàn diện các hành vi phạm tội của 

từng đối tượng.  

- Lãnh đạo nhanh chóng nắm bắt được tổng thể nội dung vụ án, từ đó đưa 

ra các chỉ đạo chính xác, kịp thời trong quá trình giải quyết.  

II. CÁC BƯỚC THỰC HIỆN 

1. Chuẩn bị trang thiết bị và cài đặt các phần mềm 

- Trang thiết bị: Máy tính, máy scan và các thiết bị khác để số hóa tài liệu. 

- Về phần mềm:  

+ Phần mềm quét tài liệu từ máy scan ra file pdf: các máy scan, máy 

photocopy đa chức năng hiện nay đều có tích hợp sẵn chức năng quét tài liệu 

giấy ra file định dạng pdf, jpg...Đối với các máy scan thế hệ cũ, có thể sử dụng 

phần mềm PaperScan Scanner.  

+ Phần mềm nhận dạng văn bản chữ Việt Nam: Sử dụng phần mềm 

ABBYYFineReader. 

+ Phần mềm cắt, ghép, chỉnh sửa file pdf: sử dụng phần mềm Foxit 

Reader, PDFMate Free PDF Merger, UltraPDFMerger, Wondershare PDF 

Editor,... 
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+ Phần mềm cắt, nối file âm thanh: phần mềm Free MP3 Cutter Joiner. 

+ Phần mềm cắt, nối file video: phần mềm Free Video Cutter Joiner. 

+ Công cụ vẽ sơ đồ sẵn có trong bộ phần mềm Microsoft office: Word, 

Excel, Power point, Visio. 

+ Phần mềm vẽ sơ đồ: Phần mềm Draw-io. 

Ngoài ra, còn có một số phần mềm đồ họa như: Autodesk Maya, Video 

Studio Ultimate, Sweet home 3d,… để mô phỏng, dựng lại sự di chuyển, diễn 

biến hành vi của các đối tượng tham gia trong vụ án, vụ việc. 

2. Tóm tắt nội dung vụ án 

Sau khi nghiên cứu hồ sơ vụ án, lập bản tóm tắt nội dung, quá trình giải 

quyết vụ án, bao gồm các thông tin như: 

– Các cơ quan, người tiến hành tố tụng trong vụ án; 

– Những người tham gia tố tụng trong vụ án; Quá trình tố tụng giải quyết 

vụ án, các quyết định tố tụng liên quan; 

– Tóm tắt diễn biến sự việc, hành vi phạm tội, chứng cứ xác định hành 

vi phạm tội của bị can, bị cáo; 

– Nhân thân của bị can, bị cáo; 

– Việc áp dụng, thay đổi, hủy bỏ biện pháp ngăn chặn, biện pháp cương 

chế; 

– Thủ đoạn, động cơ, mục đích phạm tội; 

– Ý thức của bị can, bị cáo, nguyên nhân, hoàn cảnh phạm tội; 

– Các tình tiết tăng nặng, giảm nhẹ trách nhiệm hình sự; việc thu giữ, 

tạm giữ đồ vật, tài liệu và việc xử lý vật chứng; 

– Lý do, căn cứ để nghị truy tố, tội danh, điều, khoản, điểm của Bộ Luật 

tố tụng hình sự được áp dụng; 

– Quan điểm của các cơ quan có thẩm quyền tiến hành tố tụng đối với 

việc giải quyết vụ án. 

3. Chuẩn bị hồ sơ, tài liệu để số hóa 

Chuẩn bị tài liệu, chứng cứ có bản tóm tắt nội dung vụ án để số hóa, tạo 

các thư mục để lưu trữ theo các nhóm, gồm: 

- Nhóm 1: Các tài liệu liên quan đến các Quyết định tố tụng của Cơ quan 

tiến hành tố tụng như: Quyết định khởi tố vụ án, Quyết định phân công ĐTV, 

KSV kiểm sát điều tra; Quyết định khởi tố bị can; Quyết định nhập, tách vụ án 

(nếu có); Bản kết luận điều tra; Các Thông báo, Quyết định liên quan đến cử 

người bào chữa cho bị can…. 
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- Nhóm 2: Tài liệu, chứng cứ về hiện trường, sơ đồ, bản ảnh, biên bản 

thu giữ các công cụ phương tiện, thực hiện hành vi phạm tội, tử thi. Tùy vào 

từng vụ án khác nhau sẽ thực hiện số hóa theo từng vụ án cụ thể. 

 - Nhóm 3: Tài liệu liên quan đến bị can gồm: Lý lịch bị can, các quyết 

định tố tụng đối với bị can; bản tự khai, biên bản ghi lời khai và biên bản hỏi 

cung bị can; các chứng cứ, xác định nhân thân của bị can. 

- Nhóm 4: Tài liệu chứng cứ liên quan đến bị hại; lý lịch bị hại (nếu có); 

các quyết định trưng cầu giám định; Kết luận giám định; yêu cầu định giá tài 

sản; kết luận định giá; biên bản ghi lời khai của bị hại; lời khai đại diện hợp pháp 

của bị hại. 

- Nhóm 5: Tài liệu liên quan đến lời khai của các nhân chứng; biên bản 

ghi lời khai. 

- Nhóm 6: Tài liệu lời khai của người có quyền lợi và nghĩa vụ liên quan 

đến vụ án. 

- Nhóm 7: Các tài liệu khác liên quan đến vụ án như các Biên bản xác minh 

các đối tượng khác có liên quan  đến vụ án; Các giấy tờ chứng minh về vấn dân 

sự và bồi thường dân sự. 

4. Số hóa, sắp xếp hồ sơ 

Sử dụng các các phần mềm đã cài đặt để scan, sao chụp văn bản tố tụng, 

tài liệu, chứng cứ….theo định dạng PDF hoặc các định dạng ảnh; cắt ghép các 

file video hoặc file âm thanh, lưu trữ vào các thư mục tương ứng theo các nhóm 

tài liệu đã chuẩn bị ở Bước 2.  

5. Xây dựng báo cáo bằng phương pháp sơ đồ hóa 

Từ bản tóm tắt nội dung vụ án và dữ liệu đã số hóa, sử dụng các phần 

mềm để xây dựng báo cáo bằng phương pháp sơ đồ hóa. Một số dạng báo cáo 

bằng phương pháp sơ đồ hóa như: 

- Báo cáo bằng sơ đồ  tĩnh: Kiểm sát viên sau khi tổng hợp báo cáo theo 

quy chế, kèm theo đó xây dựng phụ lục báo cáo bằng các sơ đồ, bảng biểu đơn 

giản (sử dụng các công cụ tiện ích cơ bản Word, Excel, Power point, Visio,...) 

để thể hiện các mối quan hệ gửi các sự việc, hoặc mối quan hệ giữa các đối 

tượng, bị can, bị hại trong các vụ án, vụ việc… 

- Báo cáo án bằng sơ đồ động: Kiểm sát viên sử dụng phần mềm 

PowerPoint để xây dựng các slide trình chiếu trong đó lồng ghép, dẫn đường liên 

kết các sơ đồ hiện trường, bản ảnh hiện trường, clip… Ngoài ra, có thể kết hợp 

trình chiếu các tài liệu khác có trong hồ sơ như: Các tin nhắn điện thoại, Zalo, 

Messenger, các biên bản hỏi cung, bản tự khai của bị can, lời khai nhân chứng… 
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Báo cáo án bằng video: Kiểm sát viên sử dụng các phần mềm đồ họa 

như: Autodesk Maya, Video Studio Ultimate… để mô phỏng, dựng lại sự di 

chuyển, diễn biến hành vi… của các đối tượng tham gia trong vụ án, vụ việc. 

III. GIỚI THIỆU MỘT SỐ PHẦN MỀM VÀ CÁC TÍNH NĂNG CHÍNH 

Viện kiểm sát nhân dân tối cao đã gửi Hướng dẫn số hóa hồ sơ kèm theo 

Công văn số 636/VKSTC-C2 ngày 22/9/2019 của Viện kiểm sát nhân dân tối 

cao, các đơn vị truy cập vào địa chỉ http://ftp.vks.gov.vn/prg/SOHOA/ tải về cài 

đặt và xem hướng dẫn sử dụng một số phần mềm thực hiện số hóa và chỉnh sửa 

dữ liệu. 

Ngoài ra, để thực hiện vẽ sơ đồ nội dung vụ án, có thể sử dụng một số 

phần mềm sau: 

3.1. Phần mềm ABBYY FineReader 

3.1.1. Các bước thực hiện chuyển đổi PDF sang Word 
Bước 1: mở phần mềm ABBYY FineReader. Xuất hiện cửa sổ: 

 
Chọn Mở trong OCR Editor --> Chọn đến file PDF cần Chuyển đổi. 

(Hoặc chọn các cách chuyển đổi bên dưới đều được) 

ftp://ftp.vks.gov.vn/prg/SOHOA/
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Bước 2: Chờ chuyển đổi hoàn tất sau đó nhấn Lưu thành tài liệu 

Microsoft Word… 
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Bước 3: Đọc và sửa lỗi chính tả. 

 

3.1.2. Các bước thực hiện chuyển đổi Hình Ảnh sang Word 
Bước 1: Chụp ảnh tài liệu cần Scan. Sau đó mở phần mềm ABBYY 

FineReader. Màn hình xuất hiện cửa sổ: 

 
Bước 2: Chọn Mở trong OCR Editor --> Chọn đến các hình ảnh cần 

chuyển đổi. (Lưu ý xem thứ tự hình ảnh để tránh bị lộn tài liệu) 

 



  10  
 

 

Bước 3: Chờ chuyển đổi hoàn tất sau đó nhấn Lưu thành tài liệu 

Microsoft Word… (Tương tự như trên) 

Bước 4: Tại tệp tin  Word --> Nhấn Ctrl + A để chọn tất cả --> Chọn xoá 

tất cả định dạng.  

 

Bước 5: Định dạng lại font chữ, căn lề, đọc và sửa lỗi chính tả là hoàn tất. 

Các cách còn lại như: Chuyển đổi thành tài liệu PDF, Chuyển đổi thành 

Microsoft Word, Chuyển đổi thành tài liệu Microsoft Excel, Chuyển đổi thành 

Định dạng khác… Thì thực hiện tương tự. Nhưng sử dụng chủ yếu vẫn là Mở 

trong OCR Editor. 

3.1.3. So sánh tài liệu 

https://trungtamtinhocthaibinh.com/cach-can-le-van-ban-va-font-chu-chuan-truoc-khi-lam-bao-cao/
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Bước 1: Chọn Mở phần mềm ABBYY  sau đó chọn So sánh tài liệu 

Bước 2: Chọn mở file để mở các file cần so sánh. Sau đó nhấn So Sánh 

 

Bước 3: Xem sự khác biệt giữa các file 
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3.2. Phần mềm vẽ sơ đồ Draw-io 

3.2.1.  Giao diện làm việc 

Giao diện vẽ sơ đồ của Draw.io thường sẽ có 4 phần chính, gồm: 

Phần 1: Thanh công cụ. Phần này tương tự như thanh công cụ của các 

phần mềm soạn thảo như word, exel,…  

Phần 2: Đây là vị trí các khối hình để người sử dụng lựa chọn, sáng tạo 

đưa vào sơ đồ phù hợp với mục đích. Công cụ cho phép thực hiện thao tác kéo 

thả một cách dễ dàng khi lựa chọn được hình khối phù hợp. Kho giao diện của 

Draw.io cung cấp đa dạng và hầu như đầy đủ tất  các hình ảnh sử dụng để vẽ sơ 

đồ.  

Phần 3: Khu vực để vẽ sơ đồ, người sử dụng có thể kéo thả hình ảnh tùy 

thích từ cột (2) vào đây và điều chỉnh kích thước phù hợp. 

Phần 4: Nhiệm vụ chính của phần này là chỉnh màu cho các hình khối, 

đường line, đường mũi lên cho sơ đồ của bạn trở nên sinh động hơn. Ngoài ra 

còn hỗ trợ một số chức năng nâng cao khác. 

  

Giao diện làm việc 

3.2.2. Cách vẽ sơ đồ 

Sau khi lựa chọn hình khối phù hợp với sơ đồ cần vẽ, người sử dụng nắm 

kéo thả từ khu vực (2) sang khu vực (3) để bắt đầu chỉnh sửa phù hợp. 
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Để tạo mối liên kết giữa các hình lại với nhau, người sử dụng nhấn vào 

hình cần liên kết, lúc này hình sẽ hiện ra những mũi tên mờ tạị các cạnh. Nhấn 

vào mũi tên tại cạnh cần liên kết với hình kế bên hoặc gần đó. Sau đó hình sẽ tự 

động xuất hiện mũi tên nối liền giữa 2 hình, xuất phát từ hình người sử dụng 

chọn và kết thúc tại hình gần nhất.  

Liên kết hình trong bản đồ Draw.io 

Để thêm văn bản vào hình khối, người sử dụng nhấn chọn vào hình, sau 

đó đánh nội dung phù hợp vào bên trong. Ngoài ra, có thể chỉnh sửa chữ bằng 

thanh công cụ bên trên để nội dung được trình bày đẹp mắt hơn. 

Ngoài ra, người sử dụng có thể thêm màu vào các khối đã tạo để dễ dàng 

phân biệt từng phần bằng các chức năng trong phần trên phải của công cụ. Tại 

đây cho phép người sử dụng chỉnh màu nền, màu viền, đường kẻ của các khối 

để phù hợp với mục đích sơ đồ. 
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3.2.3. Lưu sơ đồ và xuất file 

Sau khi tiến hành các bước vẽ sơ đồ và hoàn thành được một sơ đồ theo ý 

muốn (hoặc lưu lại tạm thời để tiếp tục hoàn thành),  nhấn vào mục Tệp tin, chọn 

lưu (Hoặc phím tắt Ctrl + S), sau đó đặt tên file, chọn khu vực lưu trữ và định 

dạng file sẽ lưu.  

Bên cạnh việc lưu file, người sử dụng có thể lựa chọn hình thức “Export 

as”, để xuất file dưới nhiều dạng khác nhau như: PNG, JPEG, PDF, SVG, 

HTML, SML,… để sử dụng tùy theo mục đích. 

 

3.3. Phần mềm vẽ sơ đồ Microsoft Visio 

3.3.1. Cách sử dụng  

Bước 1: Mở Visio, giao diện đầu tiên là giao diện lựa chọn kiểu sơ đồ, 

Visio cung cấp rất nhiều kiểu vẽ sơ đồ cho các  lựa chọn (nếu không xuất hiện 

giao diện đầu thì  có thể chọn File -> New). Để vẽ sơ đồ tư duy  chọn Categories 

-> Business. 
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Bước 2: Chọn Brainstorming Diagram. 

 

 

Tiếp theo chọn đơn vị đo lường Metric Units và chọn Create. 
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Bước 3: Xuất hiện giao diện làm việc, sẽ thấy Visio có giao diện trực quan 

giống với Word, Excel... nhưng lại khác một số phần mềm vẽ sơ đồ tư duy khác. 

Phía bên trái phần Brainstorming Shapes (1) có một số hình hỗ trợ vẽ sơ đồ tư 

duy. Phần OutlineWindow (2) có thể theo dõi được toàn bộ sơ đồ tư duy một 

cách thu gọn, khi  chỉnh sửa nội dung bên sơ đồ tư duy thì 

trong OutlineWindow cũng sẽ thay đổi theo. Tương tự thay đổi nội dung 

trong OutlineWindow thì nội dung bên sơ đồ tư duy cũng thay đổi theo. 
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Có thể thu nhỏ OutlineWindow bằng cách chọn biểu tượng ghim trái, 

như vậy khi bỏ con trỏ chuột khỏi OutlineWindow thì nó sẽ được thu nhỏ lại. 

Để mở OutlineWindow thì nhấn chuột vào chữ OutlineWindow, nếu 

muốn ghim lại thì nhấn chuột vào biểu tượng ghim dọc như hình dưới. 

 

 

Bước 4: Tạo chủ đề chính (Main topic) 

Đầu tiên cần tạo chủ đề chính (Main topic), có thể kéo thả Main topic từ 

bên Brainstorming Shapes sang giao diện trắng. 

 

 
Hoặc cũng có thể chọn thẻ Brainstorming -> Main. 
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Nhấp đúp chuột vào chủ đề và nhập tên cho chủ đề, có thể chỉnh sửa font, 

size, kiểu chữ, màu chữ trong phần Font của thẻ Home. 

 

Để xóa chủ đề  nhấn chọn chủ đề và nhấn phím Delete. 
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Bước 5: Thêm chủ đề con (Subtopic) 

Chọn chủ đề chính -> chọn thẻ Brainstorming -> Subtopic. 

 

Nhấp đúp chuột và nhập tên cho chủ đề con sau đó chỉnh sửa chữ cho chủ 

đề con tương tự chủ đề chính. 
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Visio hỗ trợ  thêm nhiều chủ đề con một lúc bằng cách chọn chủ đề cần 

thêm chủ đề con và chọn Brainstorming -> Multiple Subtopics (hoặc nhấn chuột 

phải vào chủ đề cần thêm và chọn Add Multiple Subtopics). 

 

Xuất hiện Add Multiple Topics  nhập tên chủ đề con, mỗi chủ đề con viết 

trên một dòng. Sau khi nhập xong  chọn OK để thêm nhiều chủ đề con. 
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  Thực hiện thêm chủ đề đến khi nào đúng như  mong muốn là được,  có 

thể thêm bao nhiêu tùy ý. 

 

Bước 6: Chỉnh sửa sơ đồ tư duy 

3.3.2. Thay đổi kiểu hình cho chủ đề 

Chọn tất cả chủ đề trong sơ đồ tư duy (nhấn giữ phím Shift + click chuột 

chọn các chủ đề cần thay đổi kiểu hình), sau đó chọn thẻ Brainstorming -

> Change Topic. 
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Xuất hiện Change Shape các  lựa chọn kiểu hình trong New shape và 

nhấn OK để thay đổi. Trong Newshape có các kiểu hình: 

 Oval: hình oval. 

 Cloud: hình đám mây. 

 Rectangle: hình chữ nhật. 

 Line: hình đường thẳng. 

 Freehand: hình tự do/ kiểu vẽ tay. 

 Wave: hình làn sóng... 
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3.3.3. Thay đổi theme, màu sắc, hiệu ứng cho sơ đồ tư duy 

Chọn tất cả sơ đồ tư duy, tiếp theo chọn thẻ Design -> chọn lựa chủ đề sao 

cho phù hợp với sơ đồ tư duy mà  đã vẽ trong phần Themes. Nhấn nút mở rộng 

để lựa chọn nhiều chủ đề khác nhau. 

 

Phần Variants là phần màu sắc ứng với chủ đề mà  lựa chọn,  nhấn chọn 

biểu tượng More. 

 

Sau đó chọn nhiều màu sắc hơn trong phần Colors. 
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Để chọn các hiệu ứng cho các chủ đề của sơ đồ tư duy  chọn trong 

phần More -> Effects. 

 

Chọn các kiểu mũi tên trong phần More -> Connectors. 
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3.3.4. Thay đổi giao diện cho từng chủ đề 

Nhấn chuột chọn chủ đề cần thay đổi sau đó các  đổ màu (Fill), đường 

viền (Line), chọn kiểu hình (Shape Styles), hiệu ứng (Effects) trong thẻ Home. 

 

3.3.5. Thay đổi kiểu sơ đồ tư duy 



  27  
 

  Không phải chọn bất kỳ chủ đề nào trong sơ đồ tư duy mà chọn ngay 

thẻ Brainstorming -> Diagram Style. 

 
Xuất hiện Brainstorming Style  lựa chọn kiểu sơ đồ trong phần Select a 

style, phần xem trước phía bên phải cho  dễ dàng lựa chọn. Sau khi đã lựa chọn 

xong kiểu sơ đồ  chọn OK để lựa chọn. 

 

 

Sơ đồ tư duy của  sẽ được thay đổi theo kiểu  chọn: 

 

3.3.6. Thay đổi bố cục sắp xếp cho sơ đồ tư duy 

  Có thể điều chỉnh bố cục cho sơ đồ tư duy bằng cách chọn 

thẻ Brainstrorming -> Layout. 
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Xuất hiện phần Layout  lựa chọn bố cục phù hợp trong phần Select a 

layout, nhấn OK để lưu lựa chọn. 

 

 

Sơ đồ tư duy sẽ được sắp xếp theo bố cục mà  đã chọn,  có thể sắp xếp cho 

vừa trang giấy. 

 

Bước 7: Xuất dữ liệu 

3.3.7. Sao chép sơ đồ (hình vẽ) sang Word 

 Có thể sao chép dữ liệu sang Word bằng cách nhấn giữ chuột và chọn sơ 

đồ tư duy, tiếp theo nhấn chuột phải chọn Copy (hoặc nhấn tổ hợp Ctrl + C) để 

copy. 
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Mở Word, nhấn chuột phải chọn Paste hoặc nhấn tổ hợp Ctrl + P để dán. 

 

Để chỉnh sửa sơ đồ  chỉ cần nhấp đúp chuột vào sơ đồ thì sẽ xuất hiện 

phần chỉnh sửa của Visio cho  điều chỉnh. 
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3.3.8. Xuất nội dung của sơ đồ sang Word 

Chọn Brainstorming -> Export Data -> To Microsoft Word. 

 

Xuất hiện cửa sổ File Save  chọn vị trí lưu file và đặt tên file trong File 

name, sau đó nhấn Save. 

 
Trang Word chứa nội dung sơ đồ tư duy sẽ được hiển thị. 
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3.3.9. Xuất nội dung của sơ đồ sang Excel 

Tương tự như xuất sang Word,  chọn Brainstorming -> Export Data -> To 

Microsoft Excel. 

 

Xuất hiện cửa sổ File Save chọn vị trí lưu file và đặt tên file trong File 

name, sau đó nhấn Save. 
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File Excel chứa nội dung sơ đồ tư duy sẽ được hiển thị. 

 

 

Bước 8: Lưu sơ đồ tư duy. 

Chọn File -> Save (hoặc Save As) -> Browse. 

 
Chọn vị trí lưu file, đặt tên cho file trong File name và chọn định dạng cho 

file trong phần Save as type, cuối cùng nhấn Save để lưu lại. 
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3.4. Phần mềm vẽ sơ đồ Microsoft Word 

3.4.1. Cách vẽ sơ đồ trong Word bằng Smart Art 

Bước 1: Mở Word,  chọn Insert > Chọn Smart Art. 

 

Với Word 2007, 2010 và 2016 nút Smart Art nằm kế bên nút 

Shapes nhưng với word 2013 thì nút Smart Art được bố trí gọn như hình sau: 

 

 

Bước 2: Lúc này hộp Smart Art sẽ xuất hiện cho phép  chọn sơ đồ phù 

hợp với nhu cầu > Chọn OK. 
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Ở đây, có rất nhiều loại sơ đồ được gợi ý như: 

- List: Kiểu sơ đồ danh sách. 

- Process: Kiểu sơ đồ quá trình. 

- Cycle: Kiểu sơ đồ vòng. 

- Hierarchy: Kiểu sơ đồ tổ chức. 

- Relationship: Kiểu sơ đồ quan hệ. 

- Matrix: Kiểu sơ đồ ma trận. 

- Pyramid: Kiểu sơ đồ hình kim tự tháp. 

- Picture: Mẫu sơ đồ mà  có thể chèn thêm ảnh từ bên ngoài. 

 
Bước 3: Sau khi  chọn được loại sơ đồ,  cần tiến hành điền nội dung 

vào phần [Text] hiển thị trong sơ đồ. 

Ví dụ: chọn vẽ kiểu sơ đồ sơ đồ danh sách (List), nhập nội dung - chữ 

“Bánh” vào ô đầu tiên. Tương tự  điền các nội dung vào các ô còn lại. 

 

Lưu ý: Lúc này,  có thể xóa hoặc thêm bất kỳ ô nào có trong mẫu sơ đồ, 

bằng cách: 

Nếu muốn xóa: Click chọn ô muốn xóa, rồi nhấn Delete. 

Nếu muốn thêm: Click chọn ô vị trí muốn thêm, chọn Design > Add 

Shapes xuất hiện các vị trí chèn ô như: 

Add Shape After: Chèn ô ở phía sau. 

Add Shape Before: Chèn ô ở phía trước. 

Add Shape Above: Chèn ô ở phía trên một mức. 

Add Shape Below: Chèn ô ở phía dưới một mức. 
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Ví dụ:  muốn thêm một ô trên “Bánh” thì  chọn ô “Bánh” > Chọn Add 

Shapes trong phần Design > Chọn Add Shape Before. Lúc này, sẽ xuất hiện một 

ô mới phía trên ô “Bánh”,  có thể nhập lại dữ liệu vào ô.  

 
Bước 4: có thể thay đổi màu ô của sơ đồ bằng cách vào Design > Change 

Color, rồi chọn nhiều kiểu như được gợi ý. 

 

Cách vẽ sơ đồ trong word khi sử dụng Smart Art sẽ giúp  tiết kiệm thời 

gian vẽ hơn với những sơ đồ mà hệ thống đã gợi ý sẵn. 

3.4.2. Cách vẽ sơ đồ trong Word bằng Shapes 

Trước khi chọn cách vẽ sơ đồ trong Word bằng Shapes,  cần liệt kê những 

ý chính được thể hiện trên sơ đồ để rút ngắn thời gian vẽ. 

Bước 1: Mở Word,  chọn Insert > Chọn Shapes, chọn bất kỳ hình dạng 

nào mà  muốn. 
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Bước 2: Tìm vị trí muốn vẽ trên trang,  nhấn trái chuột và kéo để tạo ra 

hình. 

 
Dựa vào ý chính mà  muốn thể hiện trên sơ đồ,  tiến hành vẽ thêm số lượng 

hình tương ứng bằng cách giữ phím Ctrl trên bàn phím, đồng thời nhấn giữ trái 

chuột (sao cho xuất hiện dấu thập) rồi  tiến hành kéo thả hình ở vị trí khác. 

Nếu không thực hiện thao tác kéo thả chuột để tạo hình như trên,  tiến 

hành sao chép và dán hình bằng tổ hợp Ctrl+C và Ctrl+V. 

 

Bước 3: Tại Format,  tiến hành chỉnh style theo sở thích. 

Trong khung Shape Styles có những chức năng sau: 

 Shape Fill: Màu hình nền bên trong hình. 

 Shape Outline: Màu viền, độ dày viền, kiểu viền (nét liền, nét đứt,…). 
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 Shape Effects: Hiệu ứng hình (3D, đổ bóng,...). 

 

Bước 4:  tiến hành vẽ các mũi tên hoặc đường thẳng để thể hiện sự liên 

kết, bằng cách vào Insert > Chọn Shapes  > Chọn hình mũi tên hoặc đường 

thẳng. 

 

Nếu  muốn chỉnh độ dày của mũi tên (hay đường thẳng) thì chọn Format > 

Chọn Shape Outlines > Chọn Weight > Chọn độ dày mong muốn. 
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Khi vẽ sơ đồ trong Word mà gồm nhiều hình (đối tượng vẽ bằng Shapes), 

thì  cần nên Nhóm (group) lại để tránh bị xô lệch khi thay đổi bố cục của sơ đồ 

bằng cách nhấn phím Ctrl, rồi dùng chuột click chọn hết sơ đồ, nhấp chuột 

phải để chọn Group. 

 

Bước 5:  tiến hành điền nội dung vào hình hộp, bằng cách chọn hình, nhấp 

phải chuột chọn Add Text rồi sau đó nhập chữ vào. 
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3.4.3. Dùng Drawing Tools trong Word 

Với cách sử dụng Drawing Tools để vẽ sơ đồ trong Word, có thể tùy chỉnh 

khung vẽ để tạo phông nền đa dạng cho flowchart. 

Bước 1: Vào word, rồi chọn Insert > Chọn Shapes > Chọn New Drawing 

Canvas. 

 
Bước 2: Khung vẽ biểu đồ sẽ xuất hiện. 

  Phải thay đổi kích thước khung vẽ để toàn bộ sơ đồ nằm gọn trong khung. 
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  Tìm vị trí muốn vẽ trên khung,  nhấn trái chuột và kéo để tạo ra hình. 

 

Bước 3: Tại Format,  tiến hành chỉnh style theo ý muốn. 

Trong khung Shape Styles có những chức năng sau: 

 Shape Fill: Màu hình nền bên trong hình. 

 Shape Outline: Màu viền, độ dày viền, kiểu viền (nét liền, nét đứt,…). 

 Shape Effects: Hiệu ứng hình (3D, đổ bóng,...). 

Trong khung WordArt Styles có những chức năng sau: 

 Text Fill: Màu chữ. 

 Text Outline: Màu viền, độ dày viền, kiểu viền (nét liền, nét đứt,…) của chữ. 

 Text Effects: Hiệu ứng hình (3D, đổ bóng,...) của chữ. 
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Bước 4:  tiến hành vẽ các mũi tên hoặc đường thẳng để thể hiện sự liên 

kết, bằng cách vào Insert > Chọn Shapes  > Chọn hình mũi tên hoặc đường 

thẳng. 

 

Nếu  muốn chỉnh độ dày của mũi tên (hay đường thẳng) thì 

chọn Format > Chọn Shape Outlines > Chọn Weight > Chọn độ dày mong 

muốn. 
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Bước 5:  tiến hành điền nội dung vào hình hộp, bằng cách chọn hình, nhấp 

phải chuột chọn Add Text rồi sau đó nhập chữ vào. 

 

Bước 6: Để chèn chữ bên ngoài các ô biểu đồ đã vẽ,  chọn Draw Text Box. 
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3.4.4. Cách vẽ sơ đồ trong Word dạng biểu đồ 

Bước 1:  chọn vùng dữ liệu, chọn thẻ Insert > Chọn Charts. 

 

Bước 2: Một cửa sổ hiển thị các biểu đồ khác sẽ hiện ra để  lựa chọn. Tùy 

thuộc vào bảng dữ liệu mà  lựa chọn loại biểu đồ phù hợp. 

- Column: Dạng biểu đồ hình cột đứng hiển thị những dữ liệu thay đổi 

theo thời gian hay so sánh giữa các mục.  

- Line: Biểu đồ đường biểu thị dữ liệu thay đổi theo thời gian với các điểm 

đánh dấu tại mỗi giá trị dữ liệu. 

- Pie: Biểu đồ hình tròn, biểu diễn số liệu ở dạng phần trăm. 

- Bar: Biểu đồ cột ngang, tương tự với dạng Column. 
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- Area: Biểu đồ vùng thường được sử dụng để nhằm tập trung tới tổng giá 

trị. 

- X Y (Scatter): Biểu đồ phân tán XY, được dùng để so sánh giá trị dữ liệu 

theo từng cặp. 

- Map: Biểu đồ dạng Map được sử dụng để so sánh dữ liệu các vị trí. 

- Stock: Biểu đồ chứng khoán, thể hiện dao động lên xuống cổ phiếu, 

lượng mưa, nhiệt độ.  

- Surface: Biểu đồ bề mặt kết hợp tối ưu giữa các tập hợp dữ liệu, màu sắc 

minh họa cho các khu vực thuộc cùng một phạm vi giá trị. 

- Radar: Dạng mạng nhện thể hiện các dữ liệu đa biến, thường sử dụng để 

xác định hiệu suất, điểm mạnh và điểm yếu. 

Tại đây, chọn biểu đồ tròn > Chọn OK. 

 
Bước 3: Bảng dữ liệu dưới dạng trang tính Excel sẽ xuất hiện.  nhập dữ 

liệu vào để biểu đồ được vẽ theo dữ liệu. 

Sau khi hoàn tất,  chỉ việc tắt bảng đó đi là được. Nếu muốn sửa lại dữ liệu 

của biểu đồ thì  nhấn chọn 2 lần vào biểu đồ nhé! Bảng dữ liệu sẽ hiện ra để  thao 

tác. 
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Bước 4: Nếu muốn thay đổi kiểu biểu đồ thì nhấn chuột phải vào biểu đồ 

> Chọn Change Chart Type và lựa chọn kiểu biểu đồ mới. 

 
  

3.5. Vẽ sơ đồ tư duy bằng công cụ PowerPoint 

3.5.1. Cách vẽ sơ đồ tuy duy  

Để vẽ sơ đồ tư duy trong PowerPoint, cần tạo một slide mới và sử dụng 

SmartArt để thêm các thành phần đồ họa. Thực hiện theo các bước dưới đây: 

Bước 1: Mở một slide mới và thêm tiêu đề cho sơ đồ tư duy của . 

Bước 2: Chèn SmartArt. Những đồ họa này sẽ tạo thành bố cục của bản 

đồ tư duy. Có rất nhiều bố cục SmartArt có sẵn, nhưng bố cục Horizontal 

Hierarchy gần giống với bản đồ tư duy nhất. 



  46  
 

Bước 3: Chuyển đến Ribbon > Insert > SmartArt > Hierarchy > Horizontal 

Hierarchy. 

 

 
Bước 4: Click vào hộp đầu tiên (hộp trung tâm) và nhập chủ đề tư duy 

của. Trong ví dụ này, chủ đề cốt lõi là “Content Ideas”. 

Bước 5: Chủ đề cốt lõi sẽ được chia làm các chủ đề chính và chủ đề phụ. 

Ở đây các chủ đề chính là "Recreate Top Posts" và "Ask Your Readers". 

 

 

Bước 6: Các chủ đề phụ sẽ tương ứng với từng chủ đề chính. Ví dụ, chủ 

đề chính “Recreate Top Posts” sẽ có các chủ đề phụ là “Expand a Point” và ‘Add 

New Information”. 

Bước 7: cũng có thể sử dụng SmartArt Text box ở bên trái để thêm thông 

tin chi tiết và thêm hoặc bớt các hình của SmartArt. 
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Bước 8: Thêm hình SmartArt sử dụng công cụ text box hoặc thành công 

cụ SmartArt và truy trì hệ thống phân cấp. Bằng cách này có thể mở rộng sơ đồ 

tư duy với nhiều chủ đề hơn. 

Bước 9: Thanh công cụ SmartArt Design and Format giúp bản đồ tư duy 

đẹp hơn. 

Trong quá trình tạo bản đồ tư duy, bất cứ khi nào xảy ra lỗi, có thể 

nhấn Reset Graphic (trên thanh công cụ SmartArt Design) để trở lại trạng thái 

ban đầu. 

3.5.2. Cách liên kết trong PowerPoint 

Tạo liên kết trong PowerPoint (từ phiên bản 2010 trở lên) 

Bước 1: Tạo hình khối và hình ảnh trên slide. Nhấn vào tab Animations rồi 

nhấn tiếp vào Add Animation để chọn hiệu ứng cho ảnh. 

 

 

Bước 2: Sau khi chọn xong hiệu ứng chuyển động, tại phần Advanced 

Animation chọn Trigger rồi nhấn vào On Click of và chọn tên khối hình. 

Kết quả cũng tương tự như trên, click chuột vào hình khối để hiển thị hình ảnh. 

 

https://quantrimang.com/tao-do-hoa-smartart-trong-word-2016-144815
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Tạo Liên kết Hypelink trên PowerPoint 

Cách tạo liên kết Hyperlink này sẽ áp dụng cho toàn bộ các phiên bản 

PowerPoint để liên kết tới các slide, trang web, email… 

a. Tạo liên kết tới slide 

Bước 1: Trong slide muốn chèn các kết nối người dùng nhấn vào tab 

Insert để vẽ hình tạo nút liên kết. Tiếp tục chỉnh sửa, thay đổi lại định dạng cho 

hình khối rồi nhập nội dung. Tiếp đến click chuột phải vào hình khối và chọn 

Hyperlink. 

 
Bước 2: Hiển thị giao diện mới người dùng nhấn vào mục Place in this 

Document để liên kết nhanh tới bất kỳ một slide nào có trong file PowerPoint. 
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Khi click vào từng slide sẽ hiển thị giao diện nội dung bên cạnh tại khung 

Preview. Như vậy người dùng sẽ dễ dàng hơn trong việc chọn đúng slide mà 

mình muốn liên kết tới. Cuối cùng nhấn OK để hoàn thành tạo liên kết. 

 

b. Tạo nút liên kết truy cập web 

Bước 1: Truy cập vào trang web muốn tạo nút liên kết trên slide 

PowerPoint rồi tiến hành sao chép đường dẫn trang web. 

 
Bước 2: Cũng mở Hyperlink liên kết cho nút liên kết. Trong hộp thoại 

Insert Hyperlink, nhấn vào Existing File or Web Page và dán URL trang web đã 

sao chép vào thanh Address. Nhấn OK để lưu lại. 
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c. Tạo liên kết mở file trên PowerPoint 

Tại nút liên kết tới slide trên PowerPoint, nhấn chuột phải và chọn 

Hyperlink. Tiếp đến trong giao diện mới nhấn chọn vào Existing File or Web 

Page. Tiếp đó tìm tới file hay thư mục  muốn liên kết nhanh. Nhấn OK để lưu 

lại. Người dùng có thể chọn bất cứ định dạng file hay thư mục nào để liên kết. 

 

Để tạo liên kết tới file PowerPoint khác thì thực hiện tương tự như trên. 

Cũng cần click vào file PowerPoint để liên kết nhanh. 
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Để xóa liên kết Hyperlink đã tạo trên PowerPoint, nhấn chuột phải vào 

nút liên kết rồi chọn Remove link. Để xem được nội dung bạn nhấn F5. Các nút 

lệnh sẽ chỉ hoạt động khi chiếu slide PowerPoint, không hoạt động trong quá 

trình soạn thảo. 

 

Về cơ bản thì cách tạo liên kết, tạo Hyperlink trên PowerPoint cũng tương 

tự như trên Word và Excel. Người dùng cũng có những tùy chọn chèn sang file 

khác, trang web,... 
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3.6. Phần mềm Iclone 7  

3.6.1. Chức năng chính 

iClone là phần mềm real-time 3D animation nhanh nhất, giúp dễ dàng sản 

xuất hình ảnh động chuyên nghiệp cho phim, hoạt hình, trò chơi điện tử, phát 

triển nội dung, giáo dục và nghệ thuật. Được tích hợp các công nghệ real-time 

mới nhất, iClone7 đơn giản hóa thế giới Hoạt hình 3D trong môi trường sản xuất 

thân thiện với người dùng. Nó kết hợp hoạt hình nhân vật, thiết kế cảnh và kể 

chuyện điện ảnh, nhanh chóng biến tầm nhìn của bạn thành hiện thực.  

Character Animation: Tạo hoạt ảnh cho bất kỳ nhân vật nào ngay lập tức 

bằng các công cụ trực quan cho hoạt ảnh khuôn mặt và cơ thể. 

Facial Animation: Tạo hoạt ảnh trên khuôn mặt với tính năng đồng bộ 

hóa nhép chính xác, biểu cảm cảm xúc con rối, chỉnh sửa phím khuôn mặt dựa 

trên cơ và chụp khuôn mặt tuyệt vời trên iPhone. 

Character Generation: Tạo nhân vật 3D hình người thực tế hoặc cách 

điệu, sẵn sàng hoạt hình trong thời gian ngắn. 

Professional Animation: Các tính năng hoạt hình mạnh mẽ giúp cảnh 

chuyển động nhờ khả năng kiểm soát sáng tạo tối ưu. 

Scene & Prop: Tạo nội thất hoặc môi trường ngoài trời tự nhiên bằng 

cách kết hợp các đạo cụ và các yếu tố địa hình, bầu trời, nước, cỏ và cây cối. 

Lighting: Chiếu sáng bất kỳ khung cảnh bên trong hoặc bên ngoài nào 

bằng hệ thống chiếu sáng kéo và thả toàn diện, có các điều khiển sửa đổi trực 

quan, shadow và presets. 

Real Camera System: Tạo ra những bức ảnh chuyên nghiệp bằng cách sử 

dụng các máy ảnh tiêu chuẩn công nghiệp như Alexa, Red, Canon, v.v.! 

Superb Real-time Visuals: Tăng cường chất lượng cảnh với công nghệ 

PBR, VXGI và IBL giúp bạn biến cảnh 3D bình thường thành thế giới ảnh 

chân thực. 

Material Generation: Chỉ định và quản lý vật liệu thông qua giao diện 

được sửa đổi đơn giản để kiểm soát kết cấu, UV và cài đặt vật liệu đa kênh. 

Content Resources: Truy cập hàng nghìn nhân vật, chuyển động, phụ 

kiện và đạo cụ đã sẵn sàng để tạo hoạt ảnh mà không cần thủ tục tạo mô hình 

tốn thời gian. 

Video Compositing: Kết hợp video và cảnh 3D với hiệu ứng và phát lại 

theo thời gian thực; người dùng có thể kết hợp video làm nền và họa tiết hoặc 

biến video thành mặt phẳng hoặc biển quảng cáo. 

Import & Export: Bạn có thể nhập và xuất tất cả các loại assets 3D bao gồm; 

vật thể tĩnh, đạo cụ hoạt hình, nhân vật có xương sống và các tệp chuyển động. 
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Extensive Plug-Ins: Phục vụ cho nhu cầu cụ thể của bạn với các công cụ 

chụp chuyển động và VFX. iClone cung cấp các loại plug-in khác nhau để mở 

rộng hộp công cụ sáng tạo của bạn. 

Extending iClone7 with Python API: Người dùng sáng tạo giờ đây có thể 

dễ dàng tăng cường các tính năng hoạt ảnh và thêm các thiết bị tùy chỉnh vào 

iClone7 thông qua kịch bản Python. 

3.6.2. Cách sử dụng một số tính tăng của phần mềm 
Kích chọn biểu tượng phần mềm Iclone 7 , như hình sau: 

 

Màn hình xuất hiện cửa sổ: 

 

Cửa sổ chính bên trái Content (ấn F4 để ẩn/hiện)  bên trái. Cho phép lựa chọn: 

Project template: lựa chọn các mẫu có sẵn; 

Avatar template: lựa chọn các nhân vật có sẵn; 

Animation template: lựa chọn các chuyển động; 

Background template: lựa chọn đạo cụ nền; 

Tree template: lựa chọn đạo cụ cây; 

Media template: lựa chọn hiệu ứng video; 
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Cửa sổ chính bên trái Scene (ấn F5, để ẩn hiện cửa sổ): quản lý các tài liệu khi 

làm phim, đặt tên cho các tài liệu đó. 
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Cửa sổ chính bên trái Visual (ấn F7, để ẩn hiện cửa sổ): dùng để điều chỉnh ánh 

sáng, chỉnh màu cho các bối cảnh. 

 

 

Cách sử dụng cửa sổ chính bên phải: 

Bước 1: kéo 1 nhân vật bên cửa sổ bên trái vào cửa sổ giữa như hình sau: 

 
Sau đó lựa chọn cửa sổ phải chính Modify (ấn F6 để ẩn/hiện), như hình sau: 



  56  
 

 

Có các cửa sổ phụ sau: 

Cửa sổ phụ 1:  chỉnh sửa từng chi tiết cho nhân vật; chi tiết của cửa sổ: 

+ Facial Features: 

Muốn chỉnh từng bộ phận của khuôn mặt, kích chọn vào bộ phận trong cửa sổ: 

Solo Feature Selection. Sau đó điều chỉnh kích thước trong mục Cheeks. 
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+ Body: 
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Cửa sổ phụ 2:  diễn các chuyển động; có các cửa sổ phụ sau: 

+ Motion Puppet:  

 

Cho phép chỉnh các bước chạy của nhân vật, như hình sau: 

 
+ Direct Puppet: 

 

Cho phép điều chỉnh chuyển động của từng điểm trên nhân vật. 
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+Edit motion layer: 

 

Cho phép điều chỉnh tổng thể các điểm trên cơ thể nhân vật. 

 

+ Create script: 

Cho phép ghi lại giọng nói 
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 Record Voice: ghi âm lại để nhân vật nói theo mình. 

+ Face Pupset: 

Cho phép lựa chọn các biểu cảm 

 

Xuất hiện cửa sổ: 

 

+ Face Key: 

Cho phép lựa chọn cảm xúc 

 
Xuất hiện cửa sổ: 

 

Cửa sổ phụ 3: thay đổi màu sắc của nhân vật (quần, áo, tóc,...); xuất hiện cửa 

sổ: 
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Cửa sổ phụ 4:  lựa chọn từng điểm trên cơ thể nhân vật để thay đổi màu sắc. 

Cửa sổ phải chính Miniviewport (ấn phím F8 để ẩn/hiện): cho phép xem trước 

khi chỉnh camera. 

3.7. Vẽ sơ đồ bằng phần mềm mã nguồn mở Xmind 

3.7.1 Chức năng chính 

XMind là một phần mềm mã nguồn mở, cài đặt hoàn toàn miễn phí và đơn 

giản. Bên cạnh đó, một trong những dịch vụ miễn phí hữu ích của XMind được 

gọi là XMind Share, cho phép người dùng tải lên bản đồ tư duy của họ và chia 

sẻ chúng một cách tự do. Những người dùng khác sau đó có thể xem, nhận xét 

và thậm chí tải xuống các bản đồ tư duy đó.  

Khi sử dụng Xmind có thể tự tạo cho mình những bản đồ tư duy với thiết 

kế riêng. Còn những ai cần sự nhanh chóng thì phần mềm cũng cung cấp sẵn 

những mẫu để sử dụng. Cấu trúc trình bày trong Xmind khá đa dạng: bản đồ 

(mặc định), xương cá, bảng tính, tổ chức, cây và biểu đồ logic.  

XMind có nhiều yếu tố mà bạn có thể tùy chỉnh bản đồ và thể hiện tất cả 

các khái niệm một cách tốt hơn. Chẳng hạn như hỗ trợ hình ảnh, ghi chú, tập tin 

và thậm chí là những đường link cần thiết. Ngoài ra, các bản đồ được tạo bằng 

XMind có thể được xuất sang định dạng văn bản, hình ảnh hoặc HTML. 

3.7.2. Cách sử dụng một số tính tăng của phần mềm 
Chạy phần mềm Xmind, màn hình chính của phần mềm: 
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Lựa chọn mẫu sơ đồ phù hợp theo mong muốn: 

 
Sau khi chọn sơ đồ phù hợp, kích chọn vào nhãn của ô và sửa tên như hình sau: 

  

Muốn thêm nhánh nhỏ sơ đồ, lựa chọn nút sơ đồ cần thêm sau đó kích chọn 

Topic như hình sau: 
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  Thêm các ý phụ cho các nhánh nhỏ, kích chọn nhánh nhỏ sau đó kích chọn 

Subtopic như hình sau: 

  

Thêm quan hệ giữa các nhánh, kích chọn Relationship sau đó kích, kéo từ 

nhánh nguồn đến nhánh đích như hình sau: 

 
Thêm tổng hợp hoặc tóm lược ý, lựa chọn vùng cần thêm tóm lược, sau đó kích 

chọn Summary như hình sau: 
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Thêm các ký tự, biểu tượng; kích chọn Marker sau đó kích chọn biểu 

tượng, ký tự cần thêm như hình sau: 
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Xuất tập tin Xmind sang dạng khác, kích chọn biểu tượng danh sách ở góc 

trên bên trái của cửa sổ, sau đó lựa chọn Export -> lựa chọn dạng cần xuất như 

hình sau: 

 

  

Chia sẻ tệp tin Xmind: muốn chia sẻ tệp tin kích chọn biểu tượng danh 

sách ở góc trên bên trái của cửa sổ, sau đó kích chọn File/Share sau đó lựa chọn 

phương thức chia sẻ như hình sau: 
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Trình chiếu sơ đồ: trên thanh sơ đồ kích chọn Pitch như hình sau: 

 

3.8. Phần mềm dựng phim mã nguồn mở Blender  

3.8.1 Chức năng chính 
Blender là một trong những phần mềm chỉnh sửa video miễn phí tốt nhất 

hiện nay. Đây là một công cụ đồ họa 3D, giúp tạo ra các bộ phim hoạt hình, ứng 

dụng 3D, hiệu ứng trực quan. Phần mềm cung cấp các tính năng như mô hình 

3D, rigging, texturing, mô phỏng khói, hoạt hình, kết xuất, tạo lớp che phủ và 

chỉnh sửa video. 

Công cụ của phần mềm Blender với nhiều tính năng hơn các phần mềm 

thông thường khác. Đây là một công cụ tạo hình ảnh động 3D hoàn chỉnh, cho 

phép kết xuất, mô hình hóa, theo dõi chuyển động, và một số hoạt động khác. 

Nó cũng cung cấp các tính năng khác như chuyển tiếp, bộ lọc, kiểm soát tốc độ, 

tùy ý phối màu, ..... 

3.8.2. Cách sử dụng một số tính tăng của phần mềm 
Sau khi chạy phần mềm Blender, màn hình xuất hiện cửa sổ: 
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Thanh thực đơn trên cùng bao gồm các mục: File, Edit, Render, window,... 

- Trên thực đơn File cần lưu ý các chức năng: 

  Link: dùng liên kết các tệp tin blender với nhau; 

 Append: lấy dữ liệu từ 1 tệp tin blender khác; 

 Import, Export: nhập xuất dữ liệu từ phần mềm 3D khác. 

- Trên thực đơn Edit cần lưu ý các chức năng: 

 Preferences: thiết lập các quyền riêng tư. 

Blender chia màn hình thành các phân vùng, như hình sau: 

 
- Thanh Header như hình sau: 

 

- thanh toolbar chứa các công cụ 



  68  
 

 

- Bảng properties chứa thông tin của đối tượng: 

 

- Cửa sổ hiển thị 3D (3D view): cho phép xem đối tượng 3D 

 

 
- Cửa sổ Layout: cho phép xem các lớp trong đối tượng 3D 

 
- Muốn thay đổi kích thước của từng cửa sổ: đưa trỏ chuột đến cạnh của 

mỗi cửa sổ, kích trái chuột rồi kéo. 
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- Muốn chia nhỏ cửa sổ: đưa trỏ chuột đến cửa sổ muốn chia nhỏ, kích 

phải chuột rồi chọn Split Area 

 
- Muốn nhập cửa sổ: đưa trỏ chuột đến cửa sổ muốn chia nhỏ, kích phải 

chuột rồi chọn join Area 

- Phần mềm hiển thị sẵn các leyout trên thanh menu, Muốn hiển thị thêm 

các layout: kích vào dấu “+”như hình sau: 

 
Các layout bị mờ là các layout đã được hiển thị. 

- Muốn nhân đôi công cụ layout, kích phải chuột vào công cụ layout cần 

nhân đôi, sau đó chọn Duplicate. Như hình sau: 
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- Muốn sửa tên công cụ layout, kích đúp vào layout cần sửa sau đó sửa tên 

của layout, như hình sau: 

 

 
- Muốn xóa công cụ layout, kích phải chuột vào công cụ layout muốn xóa, 

chọn delete, như hình sau: 

 
- Cách điều khiển vùng 3D view: 

Sử dụng các chức năng trên Bảng properties. Như hình sau: 
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 Trong đó có các chức năng: 

 : dùng để di chuyển đối tượng; 

 : dùng phóng to hay thu nhỏ đối tượng; 

 : dùng để xoay đối tượng (trục tọa độ XYZ: trục X là chiều 

ngang, trục Y là chiều sâu, trục Z là chiều cao); 

Ngoài các công cụ, phần mềm để vẽ sơ đồ cơ bản đã hướng dẫn, còn một 

số phần mềm vẽ đồ họa, dựng phim chuyên nghiệp có thể ứng dụng để mô phỏng, 

dựng lại sự di chuyển, diễn biến hành vi của các đối tượng tham gia trong vụ án. 

Tuy nhiên, để sử dụng được các phần mềm này thì người sử dụng phải có kiến 

thức nhất định và thời gian để học cách sử dụng. Trong hướng dẫn này sẽ giới 

thiệu một số phần mềm để tham khảo như:  

3.9. Phần mềm chỉnh sửa video và làm phim Corel Video Studio 

Corel VideoStudio cung cấp hơn 1.500 hiệu ứng và bộ lọc, cho phép chỉnh 

sửa video nhiều camera, hỗ trợ nhiều định dạng phổ biến, chỉnh sửa video HD 

và 4K để có đoạn phim tuyệt vời. Bắt đầu với các template hoặc chỉnh sửa trên 

Timeline và kết hợp ảnh, video và audio trên nhiều track. Corel VideoStudio 

kèm theo nhiều tính năng sáng tạo, hỗ trợ video với chất lượng hình ảnh và âm 

thanh tốt. Ở mọi cấp độ kỹ năng, bạn đều có thể chỉnh sửa và tạo các video ân 

tượng ngay từ đầu. 

Corel VideoStudio một trong những phần mềm biên tập video chuyên 

nghiệp nhất hiện nay. Có thể tạo và chỉnh sửa Video, thêm hiệu ứng, chuyển đổi 

định dạng ... với Corel VideoStudio. Đây là lựa chọn tin cậy cho người dùng có 

PC cấu hình không cần cao mà vẫn muốn biên soạn video HD. 

Corel VideoStudio được đánh giá cao với khả năng xử lý các video và âm 

thanh, làm việc với các video có độ phân giải lên tới 4K. Đặc biệt, phiên bản mới 

nhất của chương trình giúp tải nhiều trách nhạc cùng lúc với tốc độ nhanh hơn 

tới 130% so với các phiên bản trước. Giao diện làm việc của ứng dụng khá gọn 

gàng và đẹp mắt với không gian Media Library, Timeline và Share tạo thuận lợi 

cho người dùng khi tạo các video trình chiếu ảnh. 

Corel VideoStudio bản mới nhất tích hợp thêm công cụ Movie Profile 

Manager giúp tạo thành profile riêng để truy cập sau này với việc lựa chọn, tùy 

chỉnh và lưu trữ các thiết lập yêu thích sau khi chỉnh sửa phim. Phần mềm cũng 

giúp xử lý các định dạng video HDV và AVCHD, tải video lên youtube theo 

cách thức đơn giản và nhanh chóng nhất. 

Corel VideoStudio cho phép quay lại màn hình hoạt động của máy tính để 

chia sẻ trình chiếu slide, bài thuyết trình, demo sản phẩm, trò chơi hoặc bài 

hướng dẫn, đưa cảnh quay màn hình của bạn lên đĩa DVD hoặc Blu-ray. Có thể 

đăng tải các Video lên nhiều dịch vụ trực tuyến như YouTube, Facebook và 

Flickr, hoặc xây dựng trang web riêng qua HTML5. Người dùng cũng được phép 

chia sẻ các Video trên các thiết bị đi động như iPad, iPhone, PSP... 
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3.10. Phần mềm thiết kế, mô phỏng Sweet home 3d 

Sweet Home 3D hỗ trợ bạn thiết kế một cách nhanh chóng và dễ dàng, 

thay đổi màu sắc, kích thước hay kết cấu của mỗi phòng, kéo thả đồ vật từ catalog 

được sắp xếp theo danh mục (cửa sổ, cửa chính, phòng khách, phòng bếp), trong 

đó có thể nhập vào các mẫu 3D tự tạo hoặc tải xuống từ nhiều trang web. Sweet 

Home 3D cho phép chuyển đổi giữa chế độ hiển thị 2D và 3D, điều hướng góc 

quay ngôi nhà từ trên không, hoặc từ tầm nhìn của những người ghé thăm ảo. 

Với Sweet Home 3D, có thể tạo ảnh thực 3D với ánh sáng tuỳ chỉnh, tạo phim 

từ đường dẫn ảo ở chế độ xem 3D và kết xuất ra định dạng SVG hay OBJ. 

Để thuận tiện trong sử dụng bạn có thể sử dụng bản Sweet Home 3D Việt 

hóa, cách dùng Sweet Home 3D khá đơn giản với dân thiết kế nhưng có thể khó 

khăn với những người bắt đầu sử dụng. Sweet Home 3D tích hợp đầy đủ các 

công cụ vẽ đễ tạo nên những hình dạng cơ bản trong ngôi nhà như thẳng, tròn 

hoặc các bức tường dốc với kích thước chính xác thông qua một vài bước đơn 

giản với chuột và bàn phím. Người dùng cũng được sử dụng các thao tác kéo thả 

để lắp cửa ra vào và cửa sổ vào những bức tường cố định. Phần mềm sẽ tính toán 

chi tiết các lỗ hỗng phù hợp cho quá trình lắp đặt. 

Sweet Home 3D cũng cho phép người dùng thêm các nội thất cho mô hình 

ngôi nhà với danh mục nhà bếp, phòng khách, phòng ngủ, phòng tắm...cùng các 

tiện nghi như bàn ghế, giường, tủ, rèm cửa, kệ bếp, bồn tắm, bồn rửa, tủ lanh, lò 

vi sóng... với các vị trí đặt thích hợp nhất. Nếu không ưng ý với một cách sắp 

xếp nào, bạn cũng được thay đổi nó dễ dàng. Phần mềm còn cung cấp các hiệu 

ứng màu sắc để làm cho các đồ vật trở nên sinh động hơn. Đồng thời, các kết 

cấu, kích thước, độ dày, vị trí và hướng của đồ nội thất, tường, sàn và trần nhà 

cũng có thể được thiết lập với những tính toán chính xác và cụ thể. 

Với các mô hình được thiết kế được phép sử dụng nó để in và kết xuất ra 

PDF, bitmap hay là ảnh vector, video và file 3D với các định dang file chuẩn, 

chia sẻ qua các hình thức gửi email, tải lên mạng... 

3.11. Phần mềm Autodesk Maya  

Autodesk Maya là công cụ mạnh mẽ cung cấp một bộ tính năng sáng tạo 

toàn diện cho hoạt hình máy tính 3D, mô hình hóa, mô phỏng, kết xuất và kết 

hợp trên nền tảng sản xuất có khả năng mở rộng cao. Maya có công nghệ hiển 

thị thế hệ tiếp theo, tăng tốc quy trình mô hình hóa và các công cụ để xử lý dữ 

liệu phức tạp. Đây là công cụ hàng đầu cho hoạt hình, mô hình hóa, mô phỏng 

và kết xuất Maya 3D cung cấp một bộ công cụ tích hợp, mạnh mẽ. Sử dụng nó 

cho hoạt hình, môi trường, đồ họa chuyển động, thực tế ảo và tạo nhân vật. 

Các tính năng của Autodesk Maya 

 Hình ba chiều thiết kế nâng cao 

 Mô phỏng nhiều yếu tố tự nhiên và môi trường như biến đổi khí hậu, 

nước và chất lỏng, lửa, thực vật và ... 

 Có nhiều công cụ để mô hình hóa và dữ liệu quản lý 

 Khả năng chuyển các thuộc tính của một đối tượng để đối tượng khá 
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 Coordination với mô hình phần mềm khác và hiệu ứng động 

 NURBS mô hình toán học - Hỗ trợ (viết tắt của NURBS) 

 Có khả năng kết hợp các yếu tố của mô hình hai chiều và ba chiều 

 Khả năng sử dụng ngôn ngữ lập trình tập lệnh và MEL (viết tắt của ngôn 

ngữ nhúng Maya) và ++ C và Python trong việc phát triển phần mềm. 


